Alpha Elettronica S.r.l.
User manual (Rev. 1) STO050K

STOO50K Portable rechargeable label maker

1. Introduction

Please read this installation guide carefully before using the product.
This manual provides basic information on safe use, installation
instructions and correct operation of the device. The device described
in this manual is intended only for the use for which it was specifically
designed. Any other use is considered improper and dangerous. Keep
this instruction sheet.

2. Description

Professional labels wherever you need them. J°|N

Designed to ensure efficiency, order and precision, our portable and | AN B ] 0 e @
rechargeable label maker is the indispensable tool for electricians, "
technicians, offices and families who want clear, resistant and always 3

Meny 40K )

handy labelling. Esc
In the electrical sector, it is ideal for labelling panels, cables, terminals,
switches and devices, offering precise and legible printing that lasts
over time, even in dusty environments or subject to temperature
changes.

But its versatility goes beyond systems: in the office it helps you
organise files, folders, archives, drawers and equipment. At home, it is
perfect for jars, containers, cables, boxes, school or stationery

supplies.

= Portable and compact - Easy to carry and use anywhere

= USB rechargeable - Long-lasting battery, no need stylus batteries

= Bluetooth app control - Instant customization from smartphone or
tablet

= Sharp and professional printing - Ideal for technical texts, codes
and names

3. Safety information
Please read the safety instructions and manual carefully before using this product. All users should pay attention to
the following safety tips.
Failure to follow the instructions and warnings may result in death or serious injury.
= DO NOT use, charge or store the label maker, USB cable and lithium battery in the following locations (otherwise
fire, electric shock, smoke or damage may occur):
- Near water, such as in a bathroom or near a water heater, or in extremely humid or cold environments.*
- In locations exposed to rain or humidity.
- In extremely dusty environments.
- In extremely hot environments such as near open flames, heaters or direct sunlight.
- Inside a closed vehicle exposed to direct sunlight.
- In locations where condensation may form.
- At high altitudes.
- During a thunderstorm.
= DO NOT use the label maker if there are foreign objects inside. If water, a metal object or any other foreign object
enters the label maker, contact your dealer.
= |If foreign objects are inserted into the label maker or its slots, connectors, ports, or battery compartment, stop
using the label maker, turn it off, and disconnect all cables.
= Stop using the label maker if any abnormalities such as odor, overheating, noise, deformation, or discoloration
occur.
* See "Specifications" for more information.
= DO NOT use a damaged USB cable.
To avoid damaging the label maker, USB cable, or lithium battery, DO NOT:
- Place heavy objects on top of them.
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- Disassemble or modify them.

- Drop or impact them.

- Get them wet, such as by handling them with wet hands or spilling liquids on them.

DO NOT let children play with the plastic bag that contained the label maker. Dispose of the bag or keep it away
from children as there is a risk of suffocation.

DO NOT use the label maker in special environments, such as near medical equipment, as electromagnetic waves
may cause malfunction of the medical equipment.

Users with pacemakers should move away from the label maker if they feel any abnormality and consult a doctor
immediately.

DO NOT bend or pull the USB cable forcefully.

DO NOT touch the USB cable or plug with wet hands, otherwise it may cause electric shock.

Use only the specified USB cable.

Please use a power adapter that is compatible with standard electrical outlets (choose a 5V 2A power adapter) and
connect the plug immediately.

DO NOT use batteries if they are damaged or leaking.

Keep batteries out of reach of children. If swallowed, contact emergency services immediately.

DO NOT use sharp objects, such as tweezers or metal pens, to remove or replace batteries.

If battery fluid (electrolyte) comes into contact with your eyes, immediately rinse them with clean water and contact
emergency services immediately.

DO NOT connect the + and — terminals together using metal objects, such as wires.

DO NOT burn batteries or dispose of them with household waste.

Keep fingers and other body parts away from the cutting unit.

DO NOT touch the cutting unit blade or insert your fingers into the label exit slot, otherwise your fingers and other
body parts may be injured.

DO NOT touch the metal parts near the print head. The print head becomes very hot during and immediately after
use, so DO NOT touch it directly with your hands.

ATTENTION
Failure to follow instructions and warnings may result in minor or moderate injury. Label maker, USB cable, lithium
battery.
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4. Technical specifications

Tape width
Maximum print width
Printing technology
Color range

Print resolution
Printing speed
Display

Available languages

Print features

Automatic shutdown

Barcode Formats

Keyboard
Supported label materials
Cutting method

Power supply
Charging time

Autonomy at full charge
Supported operating methods

Label length

Maximum number of print lines
Daily work cycle
Printhead life

Display warnings
Dimensions

Weight

Shell material

Color

Operating temperature
Storage temperature
Relative humidity

5. Package Contents
1 x Printer

1 x Standard Ribbon (4m, for testing).

1 x User Manual
1 x USB Charging Cable
1 x Case

6/9/12 mm
9 mm (0.35 ")
Thermal transfer
Monochrome
203 dpi
10 mm/s
Backlit LCD
Czech, Danish, German, English, Spanish, French, Croatian, Italian, Hungarian,
Dutch, Norwegian, Polish, Portuguese, Romanian, Slovenian, Slovak, Finnish,
Swedish, Turkish, Estonian, Latvian, Lithuanian, Brazilian Portuguese.
Stand alone:
= Font size (small, medium, large)
= Font style (normal, bold, italic, bold italic)
= Font width (normal, x 1/2, x 2)
= Automatic length, fixed (30-300 mm)
= Vertical printing, mirror inversion
= Alignment (left, center, right)
= Print density (low, medium, high)
= Label width (6, 9, 12 mm)
= Cutting line
= Multi-print (1-9)
= Sequential printing
= Frame
= Label storage
App:
= Consult the app to access all available features
Default: 5 minutes
Settable via app: 5 min - 15 min - 30 min - 1 hour - 2 hours - 4 hours - 8 hours,
disabled
Via APP
1D linear code: Codel28, Code39, Codebar, EAN-8, EAN-13, UPC-A, JAN-13
2D two-dimensional code: Qr-code, aztec, pdf417
QWERTY
PET, Heat Shrink Tubing
Manually operated cutter
Built-in 1200mAh rechargeable lithium-ion battery
USB Type-C port
2-3 hours
Prints 56 meters (8 rolls of 7 meters each of consumable material continuously) with a
time of approximately 2 hours and 10 minutes
Built-in keyboard
Mobile device with S/O Android 8.0 /iOS 9.0 or higher, with Bluetooth 4.2
transmission.
The length of each label depends on its content, with a maximum of 100 characters
per label.
6mm: 1 line, 9mm: 2 lines, 12mm: 3 lines.
60 meters (max)
50 Km (not replaceable)
Low battery, operation notifications
109 x 205,9 x 40 mm
396 g
ABS
Black
10 ~ 60 °C
5~45°C
5~95% RH

Note: The label tape is inserted into the printer.
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6. Overview printer parts

Keyboard LCD display
Label Tape = @
LCD
7 [AI[A][4]
Delete All
Aa AA< el BRER &
(EEEEEEEEL) u
FEFEFLED @ © ®© @ @
lianelTape duddauoaag Font Size Frame
Compartment BIGUG0NRAD 0 -
Label Exit Cutter SrCHE (2 Caps Mode (® Label Length

Line Feed

Indicator Light
Reset Hole

Type-C Charger Port

7. Using the label maker
7.1 Insert the label tape

1. Make sure the end of the label tape passes through the tape guide

Tape Guide

0 End of Label Tape

N

2. Pull the tape out through the tape guide about 3 cm (1.18")

Ifthe ribbon is loose, please turn the gear in the direction of the arrow
until the ribbon is tight.

.18inch /3cm
The ribbon i

Ribbon rewind wheel:
Rotate clockwise

The ribbon is
tightened.

s loose.
e~

(3 Font Stylelcons ~ ® Length Lock
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3. Open the back cover of the printer, place the label tape into the label tape compartment and feed the label tape to
the exit, then press down on the label tape until you hear a click, indicating that the installation is complete

Label Exit

End of Label Tape

7.2 Turn the power on or off

|
Power on: press O and the label maker turns on.

Power off: press O and the label maker turns off.

7.3 Change language

The label maker software is factory-set to English.

3
To change the language: He - 4/» > (Language)> OK - Select a language > OK
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7.4 Inserting text

Uppercase

Lowercase ‘ Ala Switch between uppercase and lowercase characters
Insert symbols:
Symbols Q
- «/» Select a category > OK > «/P~> Select a symbol > OK
Line feed ‘J Press to initiate a line feed

Maximum number of lines for 12 mm (0.47”) tape: three lines.

Delete text and

BS
Delete one character at a time:

Clear
Delete all characters: - (Text Only) > OK

format Or
Clear Clear
Remove all characters and formatting: > 4/p» > (Text & Format) > OK
Inserting accented characters.
A
Insert letter from keyboard “E > [i] > «/» Select an accent> OK
Accented e‘
characters g To cancel the operation, press
See section 7.10 for examples of accented characters.
The order of accented characters varies depending on the language selected on the
LCD display.
Set the label length.
Label length Menz (AL:TO): automatically adjusts the label length to the text length.

Venu' > 4/ > (Label Length)> OK - Select a value > OK

7.5 Label design

sAA
1. Font size adjustment: press to switch between large, medium and small font size.

2. Font style adjustment: press (bold) or (italic), to adjust the font style.
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3. Select a decorative frame to add to the label.
U > «/P > (select a category) OK > /P> > (select an underline/frame) = OK

4. Alignment: Adjust the text format

¥
Menu' > /P > (Alignment) > OK > «/» > (select a value) > OK

7.6 Basic settings

3 The default setting is (12mm).
Label width ] %
Mend' > /> > (Label width) > OK > «/P > (select a value: 6/9/12mm) > OK
3 Set the print density.
Print density Men *
Menu' > <4/ > (Print density) > OK > «/P > (select a value) > OK
3 Set to vertical printing.
Vertical Menu %
Menu' > /P > (Vertical) > OK > «/» > (ON) > OK

7.7 Saving label files

You can save your own labels created on the label maker. Up to nine labels can be saved and recalled for printing at a
later time. You can also edit and overwrite the stored label.

%
(Save) Create the label> M > 4/» > (File) > OK > (Save) > (Select a destination) > OK

¥
(Open) Menu: > 4/ > (File) > OK > «/P > (Open) > OK > (Select a saved file) > OK

7.8 Examples of symbols

RHO0OMEG=L®A

rOonAEE®PabRLR
OBEIJ0h00RBLE®
COoONOG+AAAAA
A AN N AN
OO0

Y

®
® =@

1000+ |
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7.9 Frame examples
4 L — - A
d @ o’ -
%
¥ 4 PP b
" . [ o)
£ &3 I S
& nNF 1 @ O
v
ook ko 100+
o
7.10 Examples of accented characters
4285283335 AAARAZEAAAA ceeCCC DDddd éeeéedésd
EEEEEEEE ¢g9GG iitijnn TITI)0I ..
7.11 Print from the label maker
7.11.1 Print a single label
Enter print content Press 5 k] Press the cutter button
to cut the label.
& N e N
e
"
I"'” I
FHETEEE]
(T HTFHE
|| ETTEERR) |
| | EE=IE) |
I\ -
\ — J
(D To prevent the ribbon from being damaged, please do not touch the Cutter Bar when the screen displays "print..."
or "Output..."
Tear off the backing paper from Attach labels to dry, flat
the back of the label along the objects.
easy-tear line.
i ™ ' N
easy-tear line
L
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7.11.2 Print multiple copies of the same label

Enter print content Press [Shift]and [G)] simultaneously
'S ™\

—

7.11.3 Print the contents of multiple labels

Enter the print content of the first copy Press [Shift]and [ v ]

() Repeat Step 2 to edit multiple copies
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8. Print from your mobile device (smartphone / tablet)

8.1 Download the app

Search for the "Print Master" app on the App Store® or Google PlayTM to download and install it.

# Download on the 9 GETITON
a [ App Store > Google Play

Print Master

8.2 User Guide

1. Enable Bluetooth on your smartphone.

2. On the label maker press O until the display lights up and turn on Bluetooth

Men: —> « [/ » = [Bluetooth) = 0K — <« /» — [ON] = 0K

3. Openthe PRINT MASTER app and follow the instructions to pair the label maker

Print Master
Bl
< Bluetooth {5 @ Pennission ceaga s
; 9 & o -> A LS Informat
:00 eamads ik 5 Orink more Bluetooth about nearby devices) authorization is
lining P |z024.08.01] Lo andere approved, you can search for connected
printer devices
= = 0, muwmw O, MNotice: this authorisation does not acquire
HEMLS, Zyshompoo &5 $Ain hosh SMARTPHONE your location information
e vou pfe] o tor ram Received files
e a Product
o .
& Luoy @Gﬂﬁ ® 1
[ — betioees] To improve location accuracy, apps and service:
can detec ietooth devices ew
Wwash%‘“: @; T:;nmm;::‘ 'z::;( Bluetooth is disabled. You can change this in

Advanced settings
Parmission Request ¥

Turn on your Bluetooth so  "Print Master)
can connect to your printer.

Go to Settings->Bluetooth or control center
to turnit on.

Welcome to Print Master
Let's print the first label!
Go to set

©

Allow Print Master to find, connect to,
and determine the relative position of
nearby devices?

Auto Connect

Allow
Don't allow
Home >
Tap on “Automatic If Bluetooth has not been previously enabled on your Tap on “Allow”
Connection” smartphone, you need to activate it. P
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Search the device

Searching for printer...

1. Make sure the printer is turned on
2, Make sure the printer is near your phone

Home »

X

Please check if the printer is turned
on

1. Long press the Power Button for 3
second! il the display or indicator light
5 an
2. If the light does not go on, please charge
the prin d try again later

F e solutions, please consult the
physical manual "Quick Start Guide”

< Connect to Printer

LM2: wil
' - 800 Tap to connect

The following printers are found

" Connecting...

Home >

Wait for the label maker
search to complete

If it is not recognized, follow
the instructions

Tap on “connect”

The label maker has been
found

When the Bluetooth connection is active, the connection icon will appear on the label maker

display.

Note: When using with Bluetooth connection, the built-in keyboard is not operational.

You are prompted to create and print the first label

Edit your first label!

Hi|your nickname

©
@ ® 8 » ¢ 0

12345678890

Printing...

Printing completed

17 il

Great! Let's explore more features on the
app

Learn More

Contact us >

Enter the text to print

Tap on “Back to Home”

3-
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Set the auto-off time

H,, Lmz800 > ? W < Connect to Printer < Printer Management
P Login/Register
€ A catey - ) Lu2800 il N
B Storage B Trading &5 Kitchen [
S Printer g Device Name LM2800
8 unit switching inch »
State of Charge 100%
3 Tutorials
Auto Shutdown Time Settings SMinute >
[ Feedback Model Serial Number Q444E5358120001
@ Setting
. q Firmware Version 0.0.7
Plant cute pets MAC address 3E:78:88:56:2D:3C
Disconnec t
it Mo
Tap on “Auto Shutdown Time
Tap on “Me” Tap on “Printer” Tap the printer Settings" and select the
desired one
Change the unit of measurement mm /inches Change language
H,, LMzs00 > 2 W < Setting < Language
['new) Language Follow System’s Language > Follow System’s Language
ER A callery
Choose your printer > English e
& Storage @ Trading & Kitchen [ Privacy Statement , =0t
Deutsch
List of Collected Persanal Information » BEE
Description Of Permissions H ftaliano
List of Shared Personal Information > Francdis
Espafial
Autherity Management >
Portugués
About System V5.9.1 ”
Polski
% [— Pycckui
—\lZ
P ‘q Suomi
Plant cute pets Agally
- Tiéng Viét
Cedtina
Turkge
Cancel
Melayu
Tap on “Unit switching” Tap on “Settings”
Tap on “Me” : « " Select language
P (mm, inches) Tap on “Language guag
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Create a new label

'O LM2800 >

BA A Galery

B Storage

@ Trading

_‘v

(" . -
Digital storage

-

e
Medicine storage

& Kitchen

o

< New Label &

Width: 1Zmm - Length: 25mm -

Test

i Style Font Shape Add v
&mm
= @ Font size — 52
. Text Sticker Border Picture
"\ ” | o : - ° Alignment = = =
-
12Zmm o Font Style B i u =
Mother an Barcode QR code Transverse
Character Pitch 0
Home
Tap “New label” Choose the width You can choose Text
Text
Sticker
Border
Picture
Barcode (1D Code)
QR Code (2D Code)
Orientation
~ Permission usage instructions

After the file storage authorization is

approved, you can use the upload, edit and

storage functions of pictures, Excel and

PDF files.

X
Coding Type EAN-13 »
Recommend Hat Animal Fla w Simple Pattern Floral Adorab W
C 1] O ® & 8 % ¢ O

Y en
TEFED
wa o9
i 8 A @

o

4 B
¥

e

Allow Print Master to access photos
and videos on this device?

Allow limited access

11213]41516]171819]10
QIWIE|IR|T|Y|UlIL}O|P

AISIDIFIGIH]J]K|L

Allow all =
. g 4 Z XCVBNM®&
ivege.- | O orttor 1T .
l - d ol .1 — v _.L ;,
Sticker Border Picture Barcode (1D Code)

Supported encoding types
Code128, Code39, Codebar,

EAN-8, EAN-13, UPC-A, JAN-

13
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4 New Label < New Label 2
x
Coding Type QR-CODE »
@ & B8 s & O
z Width: 12mm - Length: 25mm = = Width: 12mm - Length: 3mm -
112)131415161718(%9]0
QWERTYU Il OFP © (48] N © &) N
" Text Sticker Border Picture Text Sticker Border Picture
A'SDFGHJKL
| A ® ® @
’ Z x C V B N M @ Barcode QR code Trarsverse Barcode QR code Vertical
QR Code (2D Code) Transverse and Vertical Orientation
Supported encoding types
Qr-code, aztec, pdf417

Save a label in “my templates”

The data is saved exclusively on the smartphone; therefore, if you uninstall the app or change your smartphone, it will
be lost.

< New Label . < New Label 2 B, LMz00 > 2 =
@
ER A callery
My Template 2
Alpha Elettr| Alpha Elettr| =

E & Storage (3 Trading &5 Kitchen [

Width: 12mm - Length: 54mm = Width: 12mm - Length: 54mm =

0 8 0 8

Text Sticker Border Plcture Text Sticker Border Plcture

& Edit
B B & Rename
Barcode QR code Transverse Barcode QR code Transverse
- [T Delete
Tap on “Save” The message that is saving From the main page you can recall saved templates
appears (open then, edit them, rename them, delete them)
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Save alabel in “my templates” (with account)

After logging in, you will be able to use the saved data even if you change your smartphone or delete and reinstall the
APP.

< < Create account < Create account
Login/Register
a Registei:vy Email Register by Pho Register by Email Registegy Phor
Print Master Please enter your Email +86 -
Subscribe now
@ Printer Email/Phone Mumber Login ) ) ) o
Unable to receive Verification Code Unable to receive Verification Code
£ unit switching inch
@ Tutorials
Account Register
[ Feedback
©® Setting
o
From “Me” tap Create a new account or Enter your email address or mobile humber and follow
“Login/Register” log in with an existing one the instructions to complete registration

9. Charging the battery

1. Use a 5Vvdc / 2A power supply (not supplied) with a
USB Type-A port.

2. Insert the Type-C port (smaller end) of the USB cable
into the Type-C port of the label maker and connect
the Type-A port (larger end) of the USB cable to the
Type-A port of the power supply.

3. After connecting the label maker to a power outlet via
the power supply, check the status of the indicator
light: a solid red light remains on until fully charged, i el
then turns off. STEES =

4. Charge the battery of the label maker for at least 20 b
minutes for immediate use. Charging will be
completed in about 2-3 hours.

5. Since the printer may become hot during charging,
avoid placing it on flammable materials while charging.

6. Once the battery is fully charged, unplug it
immediately.

Power Adapter with
Type-A Port (not included)
DC5V/2A

USB Type-A Port

‘\, v

USB Type-C Port

Note: using the printer while charging will slow down the speed. To preserve battery life, it is not
recommended to print while the printer is charging.
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10. Cleaning and maintenance

If you experience blank prints, blurry text, and missing prints, try cleaning

your printer.

1. Before cleaning, make sure the printer is turned off and the label tape
is removed. If you have just finished printing, wait at least 30 minutes
for the printhead to cool completely.

2. Use a cotton swab soaked in alcohol or a special print head cleaning
pen (not supplied) to gently clean the surface of the print head about 5
times, removing dust and stains.

3. Wait 5-10 minutes for the alcohol to completely evaporate before using

the printer again.

Note: avoid scraping the print head with hard objects, as this may
damage it and affect print quality.

11. Reset

Method 1:

Hardware reset to be used when the label maker freezes or the keyboard is unresponsive. You can use a sharp
object, such as a needle, to press the reset hole on the right side of the charging interface.

Method 2:

Reset internal memory. For example, to reset the label maker or delete any saved label data. Press the following

buttons in order.

3 .
Menu = —) @ —> | shift

12. Error Messages

Message

Cause/Solution

Cutter Error!

The cutter lever was pressed while attempting to print or advance the ribbon. If the
ribbon is jammed in the cutter unit, remove it. Turn the label maker off and then on
again before continuing.

Text Full !

Reduce the word count to 100 characters.

Battery Low !

Recharge the battery immediately.

Line Limit !

Reduce the number of lines of text.

No Cassette !

Install the label tape into the consumables compartment of the label maker.

No Data !

Enter text before printing.
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13. Troubleshooting

Problem

Solution

The label maker does not
print.

= Make sure the ribbon cassette is inserted correctly.

= Make sure the ribbon cassette compartment cover is closed securely.

= Make sure the label maker is turned on.

= Make sure your mobile device's Bluetooth is turned on.

= Make sure the label maker is connected to your mobile device via Bluetooth.

» Make sure the label maker is not paired with another mobile device.

= Make sure the other mobile device's Bluetooth auto-reconnect setting is not
enabled.

= Make sure the label maker and mobile device are close enough to communicate.

= Make sure there are no devices that emit radio waves (such as a microwave oven)
nearby.

= If the print head is dirty, use a cotton swab dipped in a small amount of alcohol to
gently clean it.

The tape does not feed
correctly.

The tape gets stuck inside
the label maker.

= If the ribbon is folded, cut off the folded portion.

= If the ribbon is jammed, remove the ribbon cassette, remove the jammed ribbon,
and then cut off the damaged ribbon.

= Make sure the end of the ribbon is coming out of the ribbon guide.

= Make sure the ribbon is facing the label exit opening.

= Remove the ribbon cassette and reinsert it.

The screen is frozen or the
label maker is not working

properly.

See Section 11 of this manual to reset the label makers internal memory to factory
settings.

The LCD display remains
blank after power on.

Recharge the printer battery immediately.
If the charging cable is connected, make sure the USB cable is connected properly and
the printer is turned on.

Messages on the LCD
display are displayed in a
foreign language.

Please refer to section 7.3 of this guide to select your desired language.

The label maker stops
while printing a label.

The supplies may be out, replace the tape cassette.
Connect the USB power supply directly to the label maker.

Previously saved label files
are not available.

All files saved in the internal memory are deleted if the batteries run out or the USB
power is disconnected.
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14. Declaration of Conformity

Italiano: Con la presente Alpha Elettronica S.r.l. dichiara che STO050K & conforme ai requisiti essenziali ed alle
altre disposizioni pertinenti stabilite dalla direttiva 2014/53/EU.

English: Hereby, Alpha Elettronica S.r.l. declares that this STO050K is in compliance with the essential
requirements and other relevant provisions of Directive 2014/53/EU.

French: Par la présente Alpha Elettronica S.r.l. déclare que l'appareil STOO50K est conforme aux exigences
essentielles et aux autres dispositions pertinentes de la directive 2014/53/EU. Par la présente, Alpha Elettronica
S.r.l. déclare que ce STO050K est conforme aux exigences essentielles et aux autres dispositions de la directive
2014/53/EU qui lui sont applicables

German: Hiermit Alpha Elettronica S.r.l. dass sich dieses ST0050K in Ubereinstimmung mit den grundlegenden
Anforderungen und den anderen relevanten Vorschriften der Richtlinie 2014/53/EU befindet". (BMWi). Hiermit
erklart Alpha Elettronica S.r.l. die Ubereinstimmung des Gerédtes STO050K mit den grundlegenden Anforderungen
und den anderen relevanten Festlegungen der Richtlinie 2014/53/EU. (Wien)

Spanish: Por medio de la presente Alpha Elettronica S.r.l. declara que el STO050K cumple con los requisitos
esenciales y cualesquiera otras disposiciones aplicables o exigibles de la Directiva 2014/53/EU.

Portuguese: Alpha Elettronica S.r.l. declara que este STO050K esta conforme com 0s requisitos essenciais e
outras disposic¢des da Directiva 2014/53/EU.

Danish: Undertegnede Alpha Elettronica S.r.l. erkleerer herved, at fglgende udstyr STOO50K overholder de
veesentlige krav og gvrige relevante krav i direktiv 2014/53/EU

Swedish: Harmed intygar Alpha Elettronica S.r.l. att denna STO050K star | 6verensstammelse med de vasentliga
egenskapskrav och évriga relevanta bestammelser som framgar av direktiv 2014/53/EU.

Finnish: Alpha Elettronica S.r.l. vakuuttaa taten ettd STO0O50K tyyppinen laite on direktiivin 2014/53/EU oleellisten
vaatimusten ja sité koskevien direktiivin muiden ehtojen mukainen.

Dutch: Hierbij verklaart Alpha Elettronica S.r.l. dat het STOO50K in overeenstemming is met de essentiéle eisen en
de andere relevante bepalingen van richtlijin 2014/53/EU. Bij deze verklaart Alpha Elettronica S.r.. dat deze
STOO050K voldoet aan de essentiéle eisen en aan de overige relevante bepalingen van Richtlijn 2014/53/EU.

Greek: ME THN MAPOYZA Alpha Elettronica S.r.l. AHAQNEI ST0050K ZYMMOP®QNETAI MPOXZ TIZ
OYZIQAEIZ AMAITHZEIZ KAI TIZ AOINEZ XXETIKEZ AIATAZEIZ THX OAHINAZ 2014/53/EU.
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EU-Declaration of Conformity

We, the undersigned,

Company Alpha Elettronica S.r.l.

Address, City Strada Antolini 2/A, 43044 Lemignano di Collecchio (PR)
Country Italy

Phone number +39 0521 804427

Fax number +39 0521 804573

certify and declare under our sole responsibility that the following equipment:

Product description / Intended use Portable rechargeable label maker wiht interface
Bluetooth 2,402-2,480 GHz

EU: all members

EFTA: all members

Member states with restrictive use none

Manufacturer Alpha Elettronica S.r.l

Strada Antolini 2/A

43044 Lemignano di Collecchio (PR)
Alpha Elettronica

STOO50K

EU / EFTA member states intended for use

Brand name
Type/Model

is tested to and conforms with the essential requirements for protection of Health and the Safety of the user and any
other person and Electromagnetic Compatibility, as included in following standards:

Art. of Directive Standard Date of issue of the standard
3.1(a) Health EN 62479 2010

EN 50663 2017
3.1(a) Safety EN 62368-1 2020 + A11:2020
3.1(b) EMC EN 55032 2015 + A:2020

EN 55035 2017 + A11:2020

EN IEC 61000-3-2 2019

EN 610003-3 2013 + A2:2021 + AC:2022-01
3.1(b) EMC EN 301 489-17 V3.2.4
3.1(b) EMC EN 301 489-1 V2.2.3

and is tested to and conforms with the essential radio test suites so that it effectively uses the frequency spectrum
allocated to terrestrial/space radio communication and orbital resources so to as to avoid harmful interference, as
included in following standards:

Art. of Directive

Standard

Date of issue of the standard

3.2 Spectrum

EN 300 328

V2.2.2

and therefore complies with the essential requirements and provisions of Art. 3.3 too, where applicable, of the

Directive 2014/53/EU of the European Parliament and of the council of April 16, 2014 on Radio equipment and
Telecommunications Terminal Equipment and the mutual recognition of their conformity and with the provisions of

Annex Il.

Collecchio 30/07/2025

C€

ALPHA ELET: N|CA\C&_R./L.
i

Salsi Davide

Responsabile Tecnico / Technical Manager
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15. Terms and Conditions

Technical note
Alpha Elettronica S.r.l. reserves the right to make technical/dimensional changes to improve the features and the
performance of the product without prior note.

Limitation of liability

The installation, use and maintenance of the labeller item code STO050K (hereinafter referred to as the “device”) are
the sole responsibility of the user. Alpha Elettronica s.r.l. is not responsible for any direct or indirect damages resulting
from the use or malfunction of the device. Alpha Elettronica s.r.l. declines all responsibility if the device is damaged
due to human factors that cause damage, injury or loss. Alpha Elettronica s.r.l. declines all responsibility for damage
or injury resulting from improper use or failure to maintain the device. Alpha Elettronica s.r.l. is not responsible for any
type of damage, whether direct or indirect, moral, incidental, special or consequential, such as loss of data, business
interruption or financial damage. The liability of Alpha Elettronica s.r.l. is limited to the purchase price of the device. It
is advisable to carefully follow the instructions provided in the manual. It is important to comply with local regulations
and follow the specific instructions for installation and use.

Warranty

This device is covered by a 24 months warranty from the purchase date in case of any defect on the materials or
during the production. The warranty is not valid in case of improper use or misuse or alteration of any kind. The
product must be returned to the retailer in order to arrange the repair. The warranty is valid only in case the damaged
product is sent back with the invoice or receipt.

Product conformity - CE compliance
This equipment carries the CE mark and complies with the following Directives:
Directive 2014/53/EU for the marketing of radio equipment.
Directive 2011/65/EU, 2015/863/EU relating to the restriction of the use of hazardous substances in
electronic devices (RoHS).
Directive 2012/19/EE on waste electrical and electronic equipment (WEEE).

For more information visit the website www.alphaelettronica.com

The user is prohibited from making changes or modifications of any kind to the device. Variations or modifications will
cancel the conformity of the product in relation to the above standards.

Instructions for the disposal
According to the Directive 2012/19/EU (Legislative Decree 49/2014 EN62321:2009) and European Law
2018 - Law 3 May 2019, n. 37, the mark of the crossed bin on the product indicates that at the end of its life
this product must be handled separately from household waste. It must be disposed of in a responsible
manner to a collection point in order to enter the recycling process. For any information about the collecting
I points please contact the local authority or the local recycling areas.

Instructions for the disposal of batteries
According to the European Directive 2012/19/EU (Legislative Decree 49/2014 EN62321:2009) and
European Law 2018 - Law 3 May 2019, n. 37, the mark of the crossed bin on the product indicates that at
the end of its life this product must be handled separately from household waste. It must be disposed of in a
) responsible manner to a collection point in order to enter the recycling process. For any information about
Li-lon the collecting points please contact the local authority or the local recycling areas.

A
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